Don't know where to start? Perhaps these tutorials would help:

<table>
<thead>
<tr>
<th>Remove trial restrictions</th>
<th>Make a slideshow</th>
<th>Make a video from scratch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save your video without a watermark and use the program after 7 days.</td>
<td>Have your video ready in just 5 minutes using the new Montage Wizard.</td>
<td>Learn how to do basic editing using the Timeline.</td>
</tr>
</tbody>
</table>

More questions? Write us an e-mail at support@movavi.com
## Table of contents

Activating Movavi Slideshow Maker .............................................................................................................. 2  
Activating without Internet access .................................................................................................................. 3  
Activating and installing packages ............................................................................................................... 5  
Managing subscription .................................................................................................................................... 6  
Creating slideshows ......................................................................................................................................... 6  
Making a slideshow in manual mode .......................................................................................................... 10  
Creating and managing projects ................................................................................................................ 12  
  - Transferring projects ............................................................................................................................ 13  
  - Appending a project ............................................................................................................................. 13  
  - Project settings ..................................................................................................................................... 14  
Adding media files .......................................................................................................................................... 16  
Creating an intro ........................................................................................................................................... 17  
Recording video ............................................................................................................................................ 17  
Preview and organize clips .......................................................................................................................... 19  
Hiding and muting tracks ............................................................................................................................ 20  
Undo actions .................................................................................................................................................. 21  
Edit and enhance clips ................................................................................................................................. 21  
  - Cutting clips .......................................................................................................................................... 22  
  - Rotating videos and images .................................................................................................................. 23  
  - Cropping ............................................................................................................................................. 24  
  - Color adjustments ............................................................................................................................... 25  
  - Video volume ...................................................................................................................................... 27  
  - Video speed ......................................................................................................................................... 28  
  - Fading video ......................................................................................................................................... 28  
  - Image duration ...................................................................................................................................... 30  
Adding overlays ............................................................................................................................................. 30  
Creating overlays .......................................................................................................................................... 30  
Creating a freeze frame ............................................................................................................................. 34  
Removing black bars .................................................................................................................................... 35  
Fading effects ............................................................................................................................................... 36  
Scene detection ............................................................................................................................................ 37  
Slow motion .................................................................................................................................................. 38  
Editing audio ................................................................................................................................................. 39  
  - Cutting audio ........................................................................................................................................ 39  
  - Audio volume ....................................................................................................................................... 40  
  - Recording audio ................................................................................................................................. 41  
  - Extracting audio from videos .............................................................................................................. 42  
  - Looping audio ..................................................................................................................................... 44  
  - Fading audio ....................................................................................................................................... 44  
  - Equalizer ............................................................................................................................................. 45  
  - Noise removal ....................................................................................................................................... 46  
  - Audio effects ....................................................................................................................................... 46  
  - Beat detection ...................................................................................................................................... 47  
Filters ............................................................................................................................................................ 48  
Transitions .................................................................................................................................................... 49  
Titles ............................................................................................................................................................... 51  
  - Timer ..................................................................................................................................................... 52  
Stickers .......................................................................................................................................................... 53  
Animation ...................................................................................................................................................... 54  
Pan and zoom ................................................................................................................................................ 56  
Chroma key.................................................................................................................................................... 57  
Exporting videos .......................................................................................................................................... 59  
  - Export only audio.............................................................................................................................. 61  
  - Export for devices ............................................................................................................................. 62  
  - Export for TVs ................................................................................................................................. 63  
Uploading online ........................................................................................................................................ 64  
Program preferences .................................................................................................................................... 65  
  - General preferences ......................................................................................................................... 66  
  - File preferences ............................................................................................................................... 67  
  - Sharing preferences ......................................................................................................................... 68  
  - Acceleration preferences ............................................................................................................... 69  
Help and support .......................................................................................................................................... 70  
  - Keyboard shortcuts ......................................................................................................................... 71  
  - System requirements ....................................................................................................................... 71  
  - Supported formats ........................................................................................................................... 72  
OpenGL troubleshooting .......................................................................................................................... 73  
Updating the graphics card driver ........................................................................................................... 74  
Glossary ......................................................................................................................................................... 75

---

**Activating Movavi Slideshow Maker**

When you first start Movavi Slideshow Maker, it will be running in TRIAL MODE. To use the program without the trial restrictions, you will need to buy the full version and activate Movavi Slideshow Maker. If you don't have the activation key yet, click the button below to visit the site and purchase the key.
Activate the program
1. Launch the program.
2. Go to the Help menu and select Activate Software.
3. Copy the activation key from your e-mail and paste it in the activation window.
4. Click Activate.

Activating without Internet access
If the computer you have installed Movavi Slideshow Maker on is not connected to the Internet, you can activate the program via e-mail.

See detailed instructions

If you haven't received your activation key within the hour
• Check the Spam folder of your mailbox.
• Contact support

I bought Movavi Slideshow Maker, but my videos already have a watermark
After you have activated the program, you can open the movie project and re-export the movie without the watermark.

How to export videos

Activating without Internet access
1. Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail. If you already have a key, skip to the next step.

2. Open the program and go to Help > Activate Software.
3. Enter your activation key and select the Activate offline option. Click Activate.

4. In the next window, click Copy and transfer this information to a computer or device with an Internet connection.
5. When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You should receive a reply within an hour. Copy the activation key from the reply and transfer it to the computer with Movavi Slideshow Maker.

6. Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you used before. Then, paste the registration key into the box and click Activate.

If the activation is not happening
• Make sure that you have used a correct activation key. There should not be any additional symbols or spaces after the last digit of the key.
• Also make sure that the key you're using is meant for the Movavi Slideshow Maker.
• Before attempting the activation, stop the antivirus software and the firewall of the computer.
• Check that your user account has the administrator rights.
• If nothing helps, e-mail the support team.

Activating and installing packages

Expansion packages are sets of additional content, which include transitions, titles, stickers, backgrounds, and music. The packages help you achieve your creative goals, broaden your freedom of expression, and save time choosing the right artistic tools.

Acquiring a package
1. Go to Movavi Effects Store. You can also find this link in the Help menu > Movavi Effects Store. Or by clicking a cart icon in effect, transition, title or sticker collections.
2. On Movavi Effects Store web-page choose and purchase the packages you like. After the purchase is processed you will receive an e-mail with an activation key, a link to download the package, and an instruction on how to install it.

Installing a package
1. Click the link you received with the e-mail and download the package.
2. When the download is finished, open the package as you normally would open your project: double-click the file or drag and drop it in the Slideshow. The program will run the installation process.
3. In the Installing Package window click Install and follow the instructions on the screen.

Activating a package
1. Copy the activation key from your e-mail.
2. Paste it in the Activating Package window.
3. Click Activate.

Wait until the installation is finished. The new elements will appear in the corresponding categories. The categories with the new elements will have a yellow dot on them and the elements will be marked with the NEW label.

Cannot install or activate the package? Make sure that:
The Slideshow you have installed on your system supports the packages;
• You use the key that was sent to you after the purchase of a package and there are no additional symbols after the key;
• You have enough free disk space to install the package.

Managing subscription

If your subscription has expired, you need to renew it to continue using the program.

To renew your subscription, click the Renew Subscription button. A web page will open, where you can buy the license. Once you've made a purchase and received the activation key in an e-mail, copy the key and paste it into the program window. Then click Activate.

Have troubles renewing the subscription?
• If you haven't received an e-mail with the activation key within an hour, check the Spam folder in your e-mail box.
• Contact our support team. Our experts will help you figure out and solve any of the related problems.

Creating a slideshow

In this guide, you will learn how to turn your photo albums into slideshows complete with music and transitions. Follow the instructions below to open the wizard and start making your own slideshow.

Create a new slideshow
• On the welcome screen, select Slideshow Wizard.
• Or in manual mode, open the File menu and choose Create Slideshow.
Add files

1. On the Files tab, click or drag and drop your files over the window. To add a folder with the files, click the arrow in the right part of the Add Files button.
2. To sort files, click the Sort button and choose the sorting type: by name, by date or randomly. The order of files can be also changed by dragging them with the cursor.
3. To remove files, click the cross icon in the upper right-hand corner of each file. To remove several files, select the files you want to delete and click Delete Selected on the bottom panel.
4. To proceed to the next step, click Next on the bottom right-hand corner of the window, or click Templates on the top.

Choose a theme or a transition preset

1. After you've added files, switch to the Templates tab.
2. In the column on the left, select the type of transitions or the theme you need. Click a template to preview it. Themes include titles and music, while transitions don't. You may leave everything out and continue with no transitions.
3. Click Next.
Add music
1. Switch to the Music tab.
2. You can use the built-in royalty-free music tracks from the list on the left by clicking the plus button 🌟. Explore all categories of music to find the best suiting track. Add music of your choice by clicking Add Files. To hear the built-in music track, click its preview. If you need to remove a track, click the cross icon ✗ near the added track.
3. Click Next.

Add titles
If you want to add some text over your video, use opening or closing titles.
1. Switch to the Preview tab.
2. Select if you want to keep both titles, only one of them, or none.
3. Delete the default text and write your own.
4. Click Apply and preview the result in the player.

Make final adjustments (optional)
Video duration
Set the desired duration of the video: move the slider to set a specific time or select the option **Fit to music length** to make the video as long as the audio used in it.

![Video duration slider](image)

**Fill black bars**
If the resolution of the project and the files in your slideshow are different, black bars will appear. You can remove them by checking the **Fit to frame** option.

- **None** — the aspect ratio of the files will remain the same.
- **Fit to frame** — the resolution of the files will be automatically fitted to the frame size, which is 4:3.
- **Add background** — the aspect ratio of the files will remain the same, and the black bars will be filled with a built-in or a custom background.

![Fill black bars options](image)

**Volume balance**
Volume balance regulates the volume of a particular source of the sound: video or separate audio. By default, both video and music have 100% volume. To switch off the video sound, move the upper slider to the left edge of the bar. And if you can't hear the video over music, you can make it quieter by moving the lower slider to the left.

![Volume balance slider](image)

**Save your slideshow**
When you're finished with your video, switch to the **Export** tab and choose the option you need.
Save the video — go to saving your video directly from the Slideshow Wizard. To save the video, name your project, chose the format and a destination folder where you want to save your video. Then click Start and wait a few moments until your video is ready.

Continue editing — switch to the manual mode, to make additional adjustments such as adding effects, stickers, titles, and other.

Upload online — upload your video to YouTube, Vimeo or Google Drive. To save the video, name your project, chose the format and a destination folder where you want to save your video. Then click Start and wait a few moments until your video is available on the service.

Notice that you can’t go back to editing the video with the Slideshow Wizard, once you click any of these options. The program will open the project in the manual mode. To make changes to your slideshow, click Back or select any of the tabs.

See also:
- Exporting videos
- Uploading videos online

**Making a slideshow in manual mode**

In this mode you can use all the tools that the Movavi Slideshow Maker has to offer and create professional-looking videos without complicated software.

You can create a new video by creating a new project or a quick video.

1. In the File menu select Create New Project.
2. Add media files that will make up the video. Click **Add Files** or drag and drop your files over the import area.

3. Change the clip layout on the Timeline, crop images, cut videos, using the toolbar.

4. Add effects, transitions, titles, and more by changing the tabs on the left-hand side of the screen.

5. To add items to the project, drag them to the Timeline.

6. Save your video:
   6.1. Click the **Export** button.
   6.2. Choose file format.
6.3. Name the video, select a folder to save the video to and set the quality.

6.4. Click Start and wait until the processing is finished.

Make sure to save your work once in a while: in the File menu select Save Project to save the project so that you can access it later.

Creating and managing projects

A project keeps all the work on your video or slideshow. You can save the project to finish your work later, or restore your work if you need to edit something after you've finished. A new project is created automatically when you start working on a video.

Creating a new project
1. On launching the Slideshow you can start making a video right away.
2. To start a new project while working on another project, go to the File menu and select Create New Project or Create Slideshow.

Saving projects
1. Go to the File menu and select Save Project. Or use a keyboard shortcut Ctrl+S.
2. Name your project. All projects are stored in the "My Videos\Movavi Slideshow Maker\Projects" folder of your user.
3. Click Save.

You can later open the project file and continue working on it. To avoid losing your editing progress, make sure to save your project every once in a while.

Viewing videos
Project files cannot be viewed in a regular video player, and can only be opened with Movavi Slideshow Maker. To view the final video in a player, you need to first export your project to a common video format.

Opening projects
1. Open the File menu and select Open Project.
2. Find the project file, select it and click Open.

You can also open projects in several different ways:
A. Find your project in Windows Explorer and drag it onto the Slideshow window or double-click it.
B. In the Import area click Add Files and select your project.

Restoring a project from an autosave
If your computer malfunctions and you cannot save the project, some of your work may be restored using an autosave file. Rename the "autosave.mepx" file and open it in the Slideshow to continue working on your project.
**Restoring media files**
When you open a recent project, you may see a message saying that a file is missing from the project. This may happen if one of the files used in the project has been moved somewhere else or deleted from disk. In this case, click **Specify Folder** in the message box to find the files in their new location, or click **Skip** to open the project without the missing files. You can also click the magnifying glass icon and specify location of a single file. We recommend to copy all the files to your hard drive before editing.

![Image of dialog box with file names and options: Specify Folder and Skip]

---

**Transferring projects**

**Saving portable project**

A **portable project** is a kind of project that contains all the media files that comprise it. Since the program does not create copies of the files and only refers to their location on the disk, the project will only work properly on another computer if all the media files are present there as well. With the portable project saving option, you don't have to collect all the files manually.

1. Open the **File** menu and choose **Save Portable Project**
2. Set a path for your project folder to be saved to and click **Save**.
3. Then transfer the project folder to another computer with Movavi Slideshow Maker installed.

![Image of menu with Save Portable Project highlighted]

---

See also:

- **Restoring lost files**
- **Appending a project**

**Appending a project**

If you work on a big project, you might want to separate it into several smaller ones for a more convenient editing process. Then, to combine them back together, append other projects to the major one.

1. Open a project or create a new one.
2. Open the **File** menu and click **Append Project**.

![Image of menu with Append Project highlighted]
3. In a new window, find and open the project you want to combine with your current project. The project you append will be added at the end of all other clips in the current project.

### Project settings

#### How to change the video’s resolution

You can adjust the parameters of your video, such as bitrate, video resolution and frame rate. These settings affect the quality and the size of a final file. You can change them when saving your video or at any other time.

In the **Export** window click the **Advanced** button.

### Video settings

The video settings apply to all videos and photos used in the project.

**Video codec**

Codec is a program that encodes and decodes data. Codecs, as well as bitrate, use data compression and affect the size of a final media file, so it is easier to store and manage the file.

**Resolution**

The **frame size or resolution** determines the videos width and height in pixels. Open the **Resolution** list to select from the most common resolutions. For your convenience, each resolution is marked with its respective aspect ratio. Ideally, the frame size should match the resolution of the videos and photos you plan to use in your project, and should not exceed the resolution of the largest video. Smaller resolutions allow you to make the output video smaller and thus save your disc space, however, this will sacrifice some video quality due to downscaling.

To set your own resolution configurations, select the **Custom** option.

<table>
<thead>
<tr>
<th>Frame Size</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>320x240</td>
<td>4:3</td>
</tr>
<tr>
<td>640x480</td>
<td>4:3</td>
</tr>
<tr>
<td>1280x720</td>
<td>16:9</td>
</tr>
</tbody>
</table>
Aspect ratio

The aspect ratio is the ratio of the video or photo’s width to its height. The most commonly used aspect ratios are 4:3, used generally for analog TV and in many old movies, and 16:9, the standard resolution for widescreen digital video.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1280x960</td>
<td>4:3</td>
</tr>
<tr>
<td>1920x1080</td>
<td>16:9</td>
</tr>
<tr>
<td>1920x1440</td>
<td>4:3</td>
</tr>
<tr>
<td>3840x2160</td>
<td>16:9</td>
</tr>
<tr>
<td>4096x2160</td>
<td>256:135</td>
</tr>
</tbody>
</table>

A relative comparison of aspect ratios

When you add videos and photos to the project, they will be scaled to fit the specified frame size. If you add media files with an aspect ratio different from that of the project, you may see black bars appear on the sides of the video. Furthermore, if you add low-quality videos to a project set up to a high resolution (frame size), the small video may be stretched to fit the frame and thus may appear pixelized. For best results, we recommend setting the frame size and aspect ratio to match all or most of the videos and photos you are planning to use.

Examples of black bars appearing when importing videos with a different aspect ratio.

To change the aspect ratio of a project:
1. Find the aspect ratio under the player.
2. Click to see other options.
3. If you need an original aspect ratio, select the X:Y option. Note the button with the link icon to the right of the boxes. It helps maintain existing proportions when entering new values: – the proportions are constrained, allowing you to set a larger or smaller frame size without changing the aspect ratio; – you can freely enter the width and height with any proportions. Click this icon to toggle the two states.

Frame rate

Frame rate or FPS defines the frequency at which frames appear on a display per second. Frame rate affects the smoothness of the video being played. Standard frame rate in most types of videos is 24-30 frames per second. The video plays smoother at a higher value, but the file size rises as well.

Bitrate

Bitrate is the amount of digital information contained in one second of a media file. It is measured in kilobits per second (Kbps). You can control the output file size by changing the bitrate value. There are three types of bitrate available in the video editor:

- **Auto bitrate (CBR)** is a constant value set by the program and calculated according to other already set quality options such as video codec, resolution and frame rate.
- **Custom bitrate** is a constant manually entered value which is then used to process the entire video. This type of bitrate allows to predict the size of a final media file.
Variable bitrate (VBR) is an automatically picked value that is set within the set quality requirements for the video. VBR will adjust to the image using the optimal values to save the quality: lower values for a static image and higher values for a more dynamic one. But in this case it is impossible to predict the output file size.

Audio settings
Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most music tracks.

Channels
Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording music; mono sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally preferred number of channels, however, some mobile devices record sound only in mono mode.

Surround sound (5.1) has the capacity to produce sound using six channels (usually 5 speakers and a subwoofer), which allows it to create the so called participation effect. This technology is often used in home cinema systems, as well as in some game consoles and PCs.

Adding media files
To begin working on your video project, you first need to add some media files. Use your own files or any of the built-in media.

Add your files
1. On the File import tab click Add Files.
2. Select the files and click Open. They will appear on the Media bin tab.
3. From the Media bin tab drag and drop the files onto the Timeline. You can remove the selection of all files by clicking on an empty space within the bin area, or by selecting a single file. Sort files in the Media bin by clicking the filter icon.

Add built-in media
1. On the Import tab select the type of media you want: sounds, music, sample video or backgrounds.
2. Switch to a chosen tab.
3. Click the file icon to download and see it or to listen to it.
4. Choose a media file and drag it onto the Timeline to add to the project.

Arrange the files
Once you've added the files, they will appear on the Timeline at the bottom of the window. The Timeline allows you to arrange the clips in the order you want. To reorder the clips, select the clips you want to move and drag them to the new position.
Creating an intro

Intro videos are specifically designed short video clips that use visual elements and text and can be edited or customized. If you don't know where to start in making a unique intro, you can use the ones that are already made and pre-installed into the program. You will only need to change the text.

Create a new intro
1. In the Titles collection go to Intro videos.
2. Find the New intro clip and drag and drop it onto the Timeline.

Edit the intro
1. Click on the clip and the Timeline will switch to the intro editing mode.
2. Add your own media files (video, audio or pictures), effects, titles and other. Work as if you're working with a usual project, but keep in mind that your making a special introductory video.
*Before you start editing, delete the instruction clip that the new intro contains.

Save changes
Click on the toolbar to save changes and go back to the main editing mode.
To save the intro and use it in other projects, select the intro clip and click. The intro will be saved with all the other items in the collection. You can edit the intro at any time while working on the project.

Recording video
1. Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is working correctly.
2. On the Import tab of the Slideshow, click Record Video. The recording module will open in a separate window.
3. In the **Video capture device** box, choose the camera.
4. Then, select the **resolution** and **frame rate**. A larger resolution will be able to retain better quality, however, the video file size will be larger. A higher frame rate is necessary for recording motion, while static scenes can be captured with a lower frame rate.
5. In the **Audio capture device** box, choose the microphone.

6. Choose a destination folder. By default, the recordings will be saved to your Movavi Library folder. To change it, click the icon near the **Save files to** box.

7. Click **Start Capture** to begin recording the video. During capture, you can take snapshots using the camera icon on the right.

8. When you're done, click **Back to editing** at the bottom of the window. The captured files will be added to the Timeline and saved to disk.
Preview and organize clips

Use the player in the upper right-hand part of the window to preview your project.

**Current position**

Your current playback position can be controlled using the position marker under the player and on the Timeline.

For precise positioning:

- To move in 0.5 second increments, open the Playback menu and choose **Skip Forward by 0.5 Seconds** (Shift+Ctrl→) or **Skip Backward by 0.5 Seconds** (Shift+Ctrl←).
- To move precisely from frame to frame, use the **Previous frame** (Ctrl←) and **Next frame** (Ctrl→) buttons in the player. This will move the position marker exactly one frame backward or forward.
- Use the **Scale** slider to zoom in on the Timeline to make positioning easier.

**Playing the video**

1. Move the position marker to where you want to start playback.
2. Click **Play** or press the **Space Bar** key.
3. Click the **Pause** button or press the **Space Bar** again to pause playback.

**Arranging clips**

By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your mouse and drop them onto the desired position. To select multiple clips, use **Ctrl+click** or click and drag to draw a selection on the Timeline.
Working with two monitors
If you have more than one monitor, you might want to detach the player into a separate window to have more room for editing. To do that, click the **Unpin player** button under the player:

![Unpin player button](image)

The player will then open in a separate window. When you want to return the player back into the main window, click the **Pin player** button in the detached player or close the player window.

Hiding and muting tracks
If you want to see how your project looks without some clips, you can disable separate clips or entire tracks.

**Hiding clips**
To hide a clip from view, right-click the clip and choose **Hide Clip** from the pop-up menu. The clip will not appear in the player or on the finished video until you re-enable it.

![Hide Clip menu](image)

**Muting clips**
To disable a clip's sound, right-click the clip you want to mute and select **Mute Clip** from the pop-up menu. The clip will not play in the player or on the finished video.

![Mute Clip menu](image)

**Disabling tracks**
To hide an entire track from view, click the eye icon to the left of the track you want to hide.

To disable the **sound** for an entire track, click the speaker icon to the left of the track.
Undo actions

Click the **Undo** button on the toolbar or press **Ctrl+Z** to cancel an action.

If you’ve cancelled an action but want to return to it, click the **Redo** button or press **Ctrl+Y**.

Edit and enhance clips

Arrange, edit and enhance clips with the tools that you can find on the toolbar and on the **More** tab.

Learn more:

- Cutting clips
- Color adjustments
- Image duration
- Adding a watermark or a logo
- Rotating videos and images
- Video volume
- Creating overlays
- Fading video
- Cropping
- Video speed
- Removing black bars
- Creating a freeze frame
- Fading effects
The video track contains your videos with their built-in audio, photos and the transitions between them. When you add videos or photos to the project, they are automatically placed on the video track of the Timeline. To arrange clips on the video track and among the tracks, drag them with your mouse.

- You can link audio and titles to video and image clips so that they will stay in sync as you edit the project.
- You can apply filters to video and image clips on this track.
- You can also add titles to the video track, if you want to show them against a solid black background.

**Overlay track**

The overlay track is used to show a photo or video on top of the main video track. You can use overlays to show split screen footage or create a chroma key effect.

- You can add filters and any special effects to the overlay track.
- You cannot use transitions on the overlay track.
- Every overlay clip is linked to the corresponding clip on the video track.

### Cutting clips

Using Movavi Slideshow Maker, you can easily split videos into parts and cut out fragments with the **Split** tool. You can find it on the toolbar of the main window, marked with a scissors icon:

#### Splitting video into parts

1. Select the clip that you want to split.
2. Move the position marker to the moment where you want to cut the clip.
3. Click the **Split** button on the toolbar. Note that if the clip has linked audio, the audio clip will also be split.
Cutting out fragments
Step 1. Cut the clip at the beginning of the unwanted fragment
1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to catch the moment precisely.
3. Click the Split icon. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

Step 2. Cut the clip at the end of the fragment
1. Select the second clip the you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the Split icon again. The fragment should now be in a separate clip.

Step 3. Delete the unwanted fragment
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key to remove this clip. The clip will be removed, and the remaining clips on the Timeline will move to close the gap.

Trimming videos
If you only need to cut off some parts at the beginning or at the end:
1. Place your mouse pointer over the edge of the clip.
2. Click and drag the edge towards the center of the clip to trim the clip to the desired length.

For a more precise navigation:
- Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second forward or back.
- Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+← and Shift+Ctrl+→.
- Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+← and Ctrl+→ keyboard shortcuts.

Rotating videos and images
In just a few clicks, you can turn any photo or video around without having to crane your neck.

Rotating by 90 degrees
1. Select the clip you want to rotate.
2. Click the Rotate button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate the video more.
Fixing the horizon level
1. Select the clip on the Timeline.
2. Click the Crop button on the toolbar.
3. Use the Straighten slider to slightly rotate the clip inside the frame, until the horizon is level with the guides in the player.

See also:
Removing black bars
Cropping

Cropping a photo or video can help you remove black bars, cut away the edges, or permanently zoom in onto an object inside the frame.

1. Select the clip on the Timeline.
2. Click the Crop button on the toolbar to open the Crop tool, and a cropping frame will appear inside the player.
3. In the player, set the frame so that the parts you want to cut are outside it. Drag by the corners of the frame to change its size, and drag by the center of the frame to move it.
Use the Angle slider in the Crop and Rotate section on the left to rotate the crop frame.

4. Click Apply. A star icon will appear on the clip once you've applied cropping.

Removing crop
1. Click the star icon on the clip to show the list of applied effects and filters.

2. A tab will open above the toolbar. Find the Crop effect and click the cross button next to it to discard the effect.

Color adjustments
1. On the Timeline, select one or several clips that you want to adjust.
2. On the toolbar, click the color adjustments button to open the adjustments tool.
3. Select **Easy** mode to use color presets for quick and simple adjustment.

Or select **Advanced** mode to set your own settings.

When you've made your own adjustments to the image and want to save them for future use, click the **Save** button and name your preset. The new preset will appear on the **Auto Adjustments** tab.
Once you have used the adjustments, the clip will be marked with a star icon, denoting applied tools or filters.

**Video volume**

The volume of video and audio should be managed separately.

1. On the Timeline, select the video that you want to edit.
2. Click the **Clip Properties** button to open the video properties for the selected clip.

3. Drag the **Volume** slider to set the volume for the selected clips. 100% is the original volume.
   - To mute the clip, uncheck the option on the right of the **Volume** slider.
   - If the clip has a lot of volume peaks, use the **Normalize** option to raise the volume of quiet parts.
**Video speed**

Speed up or slow down a video or audio clip with the Speed slide. This can be useful if you're working on a music video and you want the video to match the tempo of the music. Slowing down videos works best on videos with a frame rate of 60 FPS (frames per second) and above. You can also change the speed of any audio clip. If you modify the speed of a video with built-in audio, the audio speed will also be changed.

1. Select the clip.
2. Click the **Clip Properties** button to open the editing tools for the selected clip.

![Clip Properties](image)

3. Drag the **Speed** slider to set the necessary video speed.

The clip's length on the Timeline will change to reflect the new speed. If you've changed video speed, the video clips will be marked with a star icon.

**Fading video**

In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading simultaneously with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.

1. On the Timeline, select the clip that you want to fade.
2. Click the **Clip Properties** button on the toolbar. The clip properties will open in the Tools panel above.
3. Set the fade length using the sliders on the Video tab.
   **Fade in** – how long in seconds it will take to fade in to full opacity at the beginning of the clip.
   **Fade out** – how long in seconds it will take to fade out from full opacity at the end of the clip.

See also:
- Adding transitions
- Fading audio

### Image duration

You can change how long each image appears in your video or slideshow either using the clip properties or you can set all images to the same length.

**Changing the length of an image**

1. On the Timeline, select the image clip that you want to edit.
2. Click the Clip Properties button to open the properties for the selected clip.

3. In the **Duration** box, enter the new length of the image. Use the following format: `hours:minutes:seconds.milliseconds`. Changes will be applied instantly.
You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip appears on the Timeline, the longer it will play in your movie or slideshow.

Setting the same length for all images
1. Click the Transition Wizard button on the toolbar.
2. Enter the preferred length into the Photo clip duration box.
3. Click Apply to All Clips to set all the images to the selected length, or select Apply to Selected to change length of the clips you selected.

Creating overlays
Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect, add a logo or watermark, create a Chroma Key effect, or insert a short clip without cutting the main video.

1. Add files to the project: a background video and a foreground video or a photo.
2. Select a clip which should go on the overlay track and drag it above the main video track.
3. Place the clip on the overlay track at the right time on the needed position. You will see a line connecting the clip on the overlay track to the clip on the video track. When you move, cut, or delete a clip on the video track, the overlay clip will be affected as well. When you move the
clip on the overlay track, an editing panel will open. If you switch to a different tool, you can go back to this panel by clicking More Tools — Video Editing — Overlay.

4. Select an overlay type.

The **Overlap** mode helps add a short fragment with no need for cutting the main video. The overlay file is shown over the main track, while it's still being played. This mode works best for creating a chroma key effect.

In **Trio** mode, select the area of an image that you want to see by moving the picture inside the frame with the mouse cursor. To zoom in or zoom out on an area, hold the Shift key, and scroll the mouse wheel.

**Applying to several clips**
You can apply one overlay mode to several clips at once.
1. Select several clips on the Overlay track.
2. Choose the overlay mode. It will be applied to all the selected clips.
Adding a watermark

Adding a watermark to your videos will protect your ownership even if it's shared all over the Internet. You can add an image overlay with your watermark or logo, or make a new one using text. We recommend using PNG images that have a transparent background. That way, a watermark will fit in the video more naturally.

**Image watermark**

1. On the **Import** tab, click **Add Files** and add the image or video that you want to use as the watermark. For the best look, use images with transparent areas.
2. Drag the watermark clip up to the overlay track to make it appear on top of other videos.
3. Double-click the watermark clip. Change the overlay setting to **picture in picture** to edit the move and resize the watermark.

You can change the opacity or duration of the watermark:

1. Select the clip and open the **Clip Properties**.
2. Move the **Opacity** slider on the top of the list.
3. In the **Duration** box enter your project length to make the watermark show for the entire time of the video, or simply drag the edges of the overlay clip.
Quick logo
1. Click **More tools** on the left sidebar and open the Logo tab.

2. Click **Add Logo**.
3. Select an image that you would like to use as a logo or a watermark. It will be added over the entire video.

Text watermark
1. Click the **Titles** button on the left and pick a nice title style for your watermark.
2. Drag the titles you like onto the beginning of the titles track at the top of the Timeline.

3. Double-click the titles and enter your watermark text. Pick a font and color. Click **Apply** when you’re done.
Creating a freeze frame

A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to emphasize a moment or create a pause to explain things to the viewer.

1. Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous frame and Next frame buttons under the player.

2. Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.

3. By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.
Removing black bars

Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black bars around them. You can remove black bars from videos following one of the ways below.

Apply filter
1. On the Timeline, select the clip with black bars.
2. Click the Filters button on the left sidebar to open the filters.
3. Find the Vertical fill filter in the Adjustments group and drag it onto the clip.

Crop the clips
If black bars appear only on one or several clips, you can cut off the edges to make the video fit better inside the frame.
1. On the Timeline, select the clip with black bars around it.
2. On the toolbar, click the Crop button.
3. A frame will appear in the player. Set this frame on the part of the video that you want to keep. Parts that are outside the frame will be cut off.
4. In the Tools tab on the left, click Apply to accept the changes.
Learn more:
Adding filters
Cropping

Fading effects

Make effects and filters fade in using the overlay track.

1. Copy the clip and paste it onto the Timeline.
2. Drag the copy of the clip on the track right above the original. Now you have two identical clips right on top of each other.

3. Double-click the clip on the overlay track and choose Overlap mode in the panel above the player.

4. Apply the effects or filters you want to use onto the upper, visible clip.
5. With the overlay clip selected, click the **Clip Properties** button and select **General** settings. There, use the **Fade in** and **Fade out** sliders to set the fading time. Here you can also set **Opacity** if you want to reduce the effect's strength for the whole clip.

The clip with the effect will gradually appear and disappear, exposing the underlying original clip.

**Learn more:**
- [Applying filters](#)
- **Scene detection**

**Scene detection**

The scenes are the parts of the video that alternate just like shots. The scenes are detected by a noticeable change of a picture on a video. For example, a section of a video that shows a close-up shot of something is a scene. A section which then shows a full shot of something is another scene. A change of landscape in a wide shot is also detected as a change in scenes.

1. Select a clip on the Timeline.
2. On the **More Tools** section, on the **Video Editing** tab, click **Scene Detection**.

3. Click **Detect Scenes**.
The video will be cut into scenes automatically. You can edit them separately or delete the ones you don’t need.

**Slow motion**

1. Select a video or an audio on the Timeline.
2. Switch to the More Tools section and on the Vide Editing tab select Slow Motion.

3. Move the slider to adjust speed. The original speed is 100%.

If you’re adding the slow motion effect to a video with an audio, the audio will have the slow motion effect as well. And the stronger the effect, the stronger the sound distortion. In this case you can mute the audio or delete it altogether.
Editing audio

Add an audio
1. To add music or other sounds to your project, open the Import tab.
2. Select File import category.
3. Click Add Files or just drag your files on the panel.

You can also use one of the built-in music or sound tracks:
1. Click the Music or Sound category and take your pick from our royalty-free music collection.
2. Drag the tracks you liked on the Timeline.

Edit an audio
To edit the audio file, double-click the audio track, the settings panel will appear.
• Use the sliders to change the volume or the speed of the audio.
• Select the Normalize checkbox to make quite parts louder and level out the volume.
• Select the Reverse checkbox to play the audio backwards.
• Move the Fade in and Fade out sliders to set the time for the audio to go from complete silence to full volume and vice versa.

Audio tracks
Audio clips can be placed on two tracks: video track and audio tracks. Audio clips that are placed on the video track and painted blue are the audio of a video file. Video file and its audio make up a single clip, which means that the audio is linked to the video and will be moved, cut and deleted together with the video. Audio clips that are placed on the audio track and painted green are independent clips. The audio track works well for a background music. By default, all new audio is added onto the audio track.

Cutting audio
Splitting audio
1. Select the clip that you want to split.
2. Move the position marker to the point where you want to split the clip.
3. Click the Split button on the toolbar (scissors icon).
The audio clip will now be split into two parts.

**Trimming audio**
To trim an audio clip from the beginning or from the end:
1. Hold your mouse pointer over the left or right edge of the clip and drag it towards the center. The length of the audio clip on the Timeline reflects the length of the sound.

If you’ve already cut the audio, but want to restore its parts, drag the edges of the clip to the opposite sides from the center of a clip.

**Cutting out parts**
1. Place the position marker onto the beginning of the unwanted fragment and click the Split button.
2. Place the position marker onto the end of the unwanted fragment and click the Split button.
3. The fragment is now separated into a clip of its own. Select that clip and click the Remove button. The clip will be removed, and the remaining clips will be moved up to close the gap.

For more precise navigation:
• Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a second forward or back.
• Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+- and Shift+Ctrl+-.
• Zoom in on the Timeline and use the position slider.
• Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+- and Ctrl+- keyboard shortcuts.

**Audio volume**
Changing volume levels works the same way for video and audio clips:
1. On the Timeline, select the clip that you want to edit.
2. Click the Audio Properties button to open the tools for the selected clip.
3. Drag the Volume slider to set the necessary level, where 100% is the original volume.
   • To mute the clip, uncheck the option on the right of the Volume slider.
   • If parts of the audio clip are too quiet, select the Normalize option to increase their volume.
Playback volume

*Only for previewing*

If you need to temporarily change the volume of playback in the editor, without changing the project's volume, click the speaker icon in the preview area and set the necessary volume level. Please note that this will only affect the volume while previewing the project in Movavi Slideshow Maker, and will not affect the output file.

Volume curves

Volume curves allow to control the volume for each part of the clip and smoothly increase or decrease the volume. Each clip has its own volume curve that starts out at 100% volume for the entire clip, and a point at its beginning. The white line on the image below is the volume curve before you add any points.

Setting the volume level

1. Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

2. Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume Point from the pop-up menu. Drag the audio point to the necessary volume level. You'll notice that the surrounding parts also move with the point to make the transition smoother.

Setting the volume for a segment of a clip

To set the volume level for a part of the clip, you'll need at least two points.

1. Create a point at the beginning and at the end of the fragment.
2. Move the white line between the points to change the volume of the segment.

Creating a volume transition between the segments

When you move the points on the curve, the parts that surround a point also move. To manage the volume more precisely, create more volume points. Then, only the parts that are the closest to these points will be changed and the rest of the curve will remain still.

Recording audio

*How to record an audio*

1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the Import panel to open recording options.
4. Set up your recording device and volume.
5. Click **Start Recording** and record the audio.
6. When you're finished, click **Stop Recording**. You'll find the recording on the Timeline.

**Set start time for audio clips**

After you've added the audio files, they will appear on the audio track of the Timeline as green clips. To change when the audio clip starts playing, drag it along the Timeline, using the ruler at the top for time reference.

**Extracting audio from videos**

If you want to use a sound track from a movie, you can extract it from a video file and use it in your project.

On the **Import** tab, click **Add Files** and choose the video or just drag a video on the panel. The file will be added to the video track on the Timeline.
To trim the parts of the video that you don't need:

1. Move the position marker to the beginning of the fragment you want to keep and click the Scissors button on the toolbar. This way you will cut off the beginning of the video.
2. Now, move the position marker to the end of the fragment you need. Click the Scissors button again, and the fragment will now be in a separate clip.
3. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.

4. The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down onto the audio track. If you don't need the video clip anymore, delete it.

5. Now you can save the project as an audio file:
   1. Click the Export button at the top of the program.
   2. In the Export window, switch to the Save Audio File tab.
   3. Select an audio format.
   4. In the Save to field you will see where on the disk the file will be saved by default. To change that folder, click Browse and select a new folder.
   5. Finally, click Start to save the audio file.
Looping audio

If the music file is shorter than your video, you can loop the audio and have the file play over again until the end of the video.

1. To copy the audio clip, right-click the audio clip on the Timeline, and choose **Copy** from the pop-up menu.
2. Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until the audio length is greater or equal to the video length.
3. Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip, and drag it to the left.

Fading audio

In the editing tools, you can add smooth fades to the beginning or the end of a clip and create a crossfade effect between audio tracks. The **Fade in** setting controls how long in seconds it will take to go from silence to full volume at the beginning of the clip. The **Fade out** setting controls how long in seconds it will take to go from full volume to silence at the end of the clip.

**Set up the fading effect**

1. Select the clip on the Timeline.
2. Click the **Audio Properties** button on the toolbar.
3. Set the fade length using the sliders on the **Clip Properties** panel.
Equalizer

Using the equalizer, you can boost or reduce the levels of specific frequencies.

Set the equalizer
1. Select an audio clip. This can also be a built-in audio clip on the video track.
2. Click More Tools on the left sidebar and find Audio Editing to open Equalizer.
3. Choose an equalizer preset to set the effect quickly. If you want to set more advanced configuration drag the volume bars to adjust the frequencies to the necessary level.
4. To save your own equalizer presets for their further use, click the Save button. In the new window enter a preset name and click OK. The created preset will appear in the presets list.
Noise removal

1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Noise Removal.

3. Use the Noise suppression slider to set the amount of noise you want to remove. Don’t set the noise suppression too high if there isn’t much noise because it can start muting other sounds.

Audio effects

Audio effects can transform the sound of an audio clip.

1. Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
2. Click More on the left sidebar and find Audio Editing to open Audio Effects.

3. Click the box in the Audio Effects section and choose an audio effect you like.
Removing effects
When you've applied an audio effect to a clip, a star icon will appear on it.

Click on the star to see a list of applied effects. Then, select the effect you don't want and click the cross button to discard the effect.

Beat detection
To make your video more dynamic, use the Beat Detection audio tool to automatically mark audio beats on the Timeline and then adjust your video to the beat of the music.

1. On the Timeline, select the music clip that you want to detect beats for.
2. Click More on the left sidebar and find Audio Editing to open Beat Detection.
3. In the Beat Detection tool, click Detect Audio Beats. The program will analyze the music and place beat markers on the Timeline.
After the beat markers have been placed, you can modify their tempo. Use the **Min. time between beat markers** slider to make the beat slower or faster.

4. Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the beat.

**Removing beat markers**
1. To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select **Remove Beats** from the pop-up menu.
2. To remove all beat markers from your project, right-click the Timeline ruler and select **Remove All Beats** from the pop-up menu.

**Filters**

**Add filters**
1. Click the **Filters** button.
2. Choose **All** to see every filter in the collection or choose the specific category you need.
3. To see the filter’s preview in the player, click on it.
4. To find a specific filter, enter its name into the search box above the filters.
5. Click the heart icon to add the filter you liked to the **Favorites** group.

6. To add a filter, drag it onto the clip you want to apply the filter to.
Hint: You can apply a filter to several clips at once. Hold the Ctrl key, select the clips on the Timeline and drag a filter onto any of the selected clips. The filter will be applied to all the clips you've selected.

Once you've applied a filter, a star icon will appear on the clip, indicating applied filters and tools.

A clip with an applied filter

**Remove filters**

1. To see the list of applied filters and tools, click on the star icon on the clip.
2. In the list, find the filter that you want to remove.
3. Click the cross button to discard the effect.

**Transitions**

Transitions are short animations that use geometric shapes and transparency to connect two clips.

**Add a transition**

1. Click the Transitions button on the left sidebar to open the list of all transitions. Click on a transition to preview it in the player.
2. Pick a style you like and drop it between two clips on the Timeline. Click the heart icon to add it to your favorites list if you like it.
A transition icon will appear between the two clips.

**Change transition length**
1. Select a transition on the Timeline.
2. Hover the mouse cursor over any edge of a transition icon. A double-headed will appear. If you can't properly grip the edge, increase the scale of the Timeline on the bottom left corner.
3. Drag the edge to the right to increase the length of a transition. Drag the edge to the left to decrease the length of a transition.

Or set the exact duration
1. Double-click a transition on the Timeline to open transition properties.
2. Enter the new transition length in the **Duration** field. By default, each transition will be set at 2 seconds long. The format is **seconds.milliseconds**. If you want all transitions that are currently in the project to have the same length, select the **Apply to all transitions** option.
3. Click **OK** to apply the changes.

There are more options to fill the transitions with, such as:
- **Trimmed content** — If you've trimmed the video, the trimmed bits will appear during the transition. If the videos haven't been trimmed, a freeze frame is shown.
- **Freeze frame** — A static frame is shown during the transition.
- **Slow motion** — The part of the video overlapped by the transition is stretched to fill the entire duration.
Remove a transition
1. Right-click the transition on the Timeline and select **Remove Transition** from the pop-up menu.
2. If you want to delete all the transitions in your project, choose **Remove All Transitions**.

![Remove Transition](image)

Titles

Add text to your video
1. Click the **Titles** button on the left side of the window to view the titles collection.
2. Click on a title style to preview it in the player and choose the titles you want to use. To add titles to your favorites, click the heart icon.
3. Pick a title style and drag it onto the title track of the Timeline. Put it right above the video track, onto the time where you want them to appear.

![Add to favorites](image)

4. You can link titles to the clips by clicking the link icon on the left side of the title track, so that the titles will move with the clip.

Editing titles
To change the titles, double-click the title clip on the Timeline. The settings panel will appear.
1. On the **Text** tab, change the text of a title, the color of the text, its font, and alignment. Switch between the lines of the title by clicking the arrows on the left of the text box. You can also change the text within the player by double-clicking the title.
2. On the **Clip** tab, change the duration of the clip and animation speed of a title.
3. To change the color of the style and switch to the **Color** tab, select a non-text element of the title in the player.
4. On the **New Preset** tab, save the title preset with the adjustments you made to use it in other projects.
5. Click **Apply** to save the changes.
6. To change the position of a title on the screen, double-click a clip on the Timeline. In the player, you will see a frame appear around the object. Drag the corners of the frame to change the size and drag the object itself to move it. To rotate titles, click and drag the top white dot of the frame.

Move several objects at once by selecting them with the mouse cursor or by holding the Ctrl key and clicking the objects with the left mouse button.

See also:

Adding a timer

**Timer**

**Add a timer**
1. Click the Titles button on the left sidebar to open the list of the text styles.
2. Find the Timer title style. Use the search bar or click the Basic group to filter the styles.
3. Drag the Timer titles onto the title track of the Timeline. To change the length of the timer, drag the edges of the clip.

**Edit the timer**
1. Double-click the timer clip on the Timeline.
2. Edit the text formatting on the **Text** tab, if needed.
3. Switch to the **Timer** tab.
4. Change the time format to the suitable one, for example, ss:zzz.
5. In the **From** field, set the starting time. If you select to set a countdown, it will also begin from the time you set in the **From** field.

![Clip Editing](image)

---

### Stickers

**Add stickers**

1. Click the **Stickers** button on the sidebar to open the list of stickers.
2. Click on a sticker to preview it in the player and choose which you want to use. To add a sticker to your **favorites**, click the heart icon.
3. Select the sticker and drag it onto the title track of the Timeline. All titles and stickers go on the title track. Change the length of a sticker to make it fit the clip.

![Stickers](image)

---

### Edit a sticker

1. Double-click the clip to open the sticker settings.
2. Set the duration of your sticker.
3. Click **Apply** to save the changes.
4. To change the sticker’s position on your video, double-click a sticker clip. In the player, drag the corner of the frame to change its size, and drag the center of the frame to move the sticker. To rotate the sticker, click and drag the white dot at the top of the frame.
5. Click **Apply** when you’re finished.
Transitions cannot be applied to stickers, but you can animate them.

Learn more:
Animation

**Animation**

You can move objects any way you want and make creative appearances.

**Add animation**
1. Add the background onto the main video track.
2. Add the object you want to animate.
3. Click More and on the Video Editing tab choose Animation.

4. The Easy animation tab includes presets with a simple animation, that you can quickly drag and add to a clip. To create your own unique animation, switch to the Advanced tab.

**Advanced mode**
1. Select the clip you want to animate and place the position marker where you want your animation to start.
2. In the Animation panel, click Add Animation.
3. In the player, you will see a frame appear around the object. Use it to set the position of the object. On the Timeline, two points will appear on the clip. They are called keyframes. The first point is the original position of the object. The second point is its end position after the animation. The distance between the two points determines the animation speed.

**Edit the keyframes**
1. On the Timeline, double-click a keyframe to edit it.
2. In the player, use the frame to move the object to where you want it to go.
   - To change the object's size, drag by the corners of the frame.
   - To rotate the object, drag by the white dot at the top of the frame or use the Angle box in the Animation panel. Note that if you want to make the object spin, you can rotate it to a maximum of 180 degrees in a single keyframe.
   - To make the object fade in or out, use the Opacity slider in the Animation panel.
3. To change how fast the object moves, move the keyframe point on the clip:
   - Move the points closer together to make the animation go faster.
   - Move the points farther away from each other to make it go slower.

To add another keyframe, move the position marker to where you want to place it in the clip and click Add Keyframe on the Animation panel. If you add it between two existing keyframes, it will create an intermediate position.
Reset a keyframe
To make a keyframe go back to its original position, right-click the keyframe point on the clip and select Reset Keyframe in the pop-up menu.

Remove keyframes
1. To remove one keyframe, right-click the keyframe point on the clip and select Remove Keyframe in the pop-up menu.
2. To remove all keyframes and delete the animation, right-click any of the keyframe points and select Remove All Keyframes.

Pan and zoom
You can control the camera movement using two keyframes and smoothly move from one frame to another.

Add the Pan and Zoom tool
1. On the Timeline, select the clip that you want to zoom.
2. To open the Pan and Zoom, select More on the left sidebar and find the Pan and Zoom tool in the Video Editing.
3. Select one of the presets and drop it on a clip. This will add two keyframes to the clip. The camera will move between these two keyframes and you can set up camera movements from one point to another.
4. To change the beginning keyframe, double-click the first point of the clip and to change the ending keyframe, double-click the second point of the clip. Then use the frame in the player to set the zoom level for each point of the camera movement.
To change the length of the zoom effect, move a keyframe left or right. To move the zooming effect on the clip without changing its length or other settings, move it along the clip. Repeat steps 2-4 to combine other camera movements in one clip. For example, you can zoom in on an object, pan across the frame with the same zoom level, and then zoom back out to 100%.

**Add the Pan and Zoom effect automatically**
1. Click the **Transition Wizard** button on the panel above the Timeline.
2. Scroll down and find the **Pan and Zoom** tool.
3. Click **Apply to All Clips** to apply the effect to all clips in the project.

If you want to apply the effect only to several clips in the project
1. Select the clips you want to add Pan and Zoom to. If the clips are placed far away from each other, hold the Ctrl key and click the clips one by one.
2. Click the arrow on the button in the Pan and Zoom tool area. Then click **Apply to Selected**.

**Remove zoom**
To remove a pan or zoom effect, right-click a keyframe and select **Remove All Keyframes** to clear all zoom effects from the clip. To remove only the selected keyframe, select **Remove Keyframe**.

**Chroma key**
The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent. To make the Chroma key work, you should use a bright green or blue background. Do not use videos with white, gray, or black backgrounds.

**Add Chroma Key**
1. Add video or image clips that you want to use as the foreground and the background.
2. Select the foreground video and move it up, onto the **Overlay track**.
3. In the **Overlay** properties select the **Overlap** mode, to make the foreground video completely cover the background video.

4. In the player, adjust the position of the overlay video.

5. Select the video on the overlay track, click the **More Tools** button on the left sidebar, and in the **Video Editing** list find **Chroma Key**.

6. Once you open the **Chroma Key** tool, move your mouse cursor over the player and click on the color that you want to remove. The color you’ve picked will become transparent.
For a better result adjust the settings:
Tolerance — Set how many similar shades of the selected color should also be removed.
Noise — Choose how sharp the object’s edges should be.
Edges — Choose how thick the object’s edges should be.
Opacity — Set the transparency of the background.

7. Click **Apply** to save the changes.

**Exporting videos**

When you’re done with your project, you’ll need to export it as a media file to be able to play it on the devices. This section will guide you through the process of exporting your project to a popular video format. If you want to find out more about other ways of saving videos, see the following guides:

- Saving videos for devices
- Uploading videos online

### Exporting a full video

1. To start saving the video, click the **Export** button under the player. The export settings window will open.

2. Choose a format for saving the video in.

Some formats allow you to choose between video codecs. If you don’t know which format to choose, try using **MP4**. The MP4 format is supported by most platforms and operating systems.

At lower resolutions, the file will be significantly smaller, however, the video will lose some quality due to the limitations of digital data compression.

The **GIF** format is different from other formats in the list. It allows saving video as a mute animated image, which can then be played in some image viewing programs or in any web browser.
3. (optional) To change the resolution, aspect ratio, or other settings, click the **Advanced** button to view and edit the project settings.

4. If your project is heavy on small details and filters, you can select **High** or **Highest** quality to export the finished video with a higher bitrate. This will increase the output file size but will preserve better quality. For most other projects, **Good** quality will provide a nice result at a small file size.

5. Name your file and choose a destination folder. Next to the **Save to** field click the **Browse** button to change the directory for saving the output file. You can change the default output folder in the **preferences**.

6. Click the **Start** button to begin processing the video file. This may take up to a few minutes.
Exporting a part of a video

Sometimes you might need to export only a part of a project. To do this:
1. Open the **Save** menu, then select **Add Selection**. A purple area will appear on the Timeline.
2. Drag the dots that limit the area and select the part of the video you want to export.
3. Open the **Save** menu again and select **Export Selection**. Or right-click the area and choose **Export Selection**.
4. Save the video as shown in the **Exporting a full video** section above.

See also:
- **Export only audio**
- **Export for devices**
- **Export for TVs**
- **Uploading online**

Export only audio

This section will guide you through exporting just the audio track of your project.
1. Click the Export button under the player area to open the export settings window.

![Export settings window]

2. Click on the Save Audio File tab in the left part of the Export window.
3. Select the format you'd like to save the audio in.

![Audio format selection]

While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high audio quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the original files: due to data compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC audio, and vice versa – high quality files may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.

5. Name your file and choose a destination folder. Next to the Save to field click the Browse button to change the directory for saving the output file. You can change the default output folder in the preferences.
6. Click the Start button to begin processing the video file. This may take up to a few minutes.

![Start processing]

**Export for devices**

This guide will help you export your video project for playing on mobile phones, tablets, and other devices.

1. Click the Export button under the player to open the export settings window.
2. In the left part of the window click on the **Save for Devices** tab.
3. Select a format.

On this tab you will find a number of different types of devices for which you can choose a format. You can choose between devices running iOS (iPhone, iPad, iPad mini) or Android, Samsung Galaxy S6 and Galaxy S7, Google Nexus 6 and Google Pixel, as well as PlayStation console. If your device is not on the list, choose **Other**.

4. If your project is heavy on small details and filters, you can select **High** or **Highest** quality to export the finished video with a higher bitrate. This will increase the output file size but will preserve better quality. For most other projects, **Good** quality will provide a nice result at a small file size.
5. Name your file and choose a destination folder. Next to the **Save to** field click the **Browse** button to change the directory for saving the output file. You can change the default output folder in the preferences.
6. Click the **Start** button to begin processing the video file. This may take up to a few minutes.

---

**Export for TVs**

This guide will help you export your video project for playing on Smart TVs.

1. In the bottom right hand corner of the Editor, click the **Export** button to open the export settings window.
2. In the left part of the window click the **Save for TVs** tab.

3. Choose a TV preset. If your TV is not on the list, choose **Other 1080p TVs** or **Other 4K TVs**.

4. If your project is heavy on small details and filters, you can select **High** or **Highest** quality to export the finished video with a higher bitrate. This will increase the output file size but will preserve better quality. For most other projects, **Good** quality will provide a nice result at a small file size.

5. Name your file and choose a destination folder. Next to the **Save to** field click the **Browse** button to change the directory for saving the output file. You can change the default output folder in the **preferences**.

6. Click the **Start** button to begin processing the video file. This may take up to a few minutes.

---

**Uploading online**

After you finish your video, you can share it to YouTube, Vimeo or Google Drive right from the export window.

1. Click the **Export** button under the player.
2. In the left part of the window click the **Upload Online** tab.

3. Click **Sign in**. The authentication page will open in your browser. Sign in to your account and click **Allow** to let Movavi Slideshow Maker upload videos.

---

**Upload to YouTube**

1. Fill in the **title** and **description** for your video.
2. Add some **tags** to help users find videos by relevant topics. Separate tags with commas and add a number sign (#) before each one.
3. Choose a **category** to help viewers find relevant content.
4. Open the **Privacy** box and choose who you want to see the video:
   - **Private** – videos can only be seen by you and the users you choose.
   - **Public** – videos can be seen by and shared with anyone.
   - **Unlisted** – videos can be seen and shared by anyone with the link.
5. On the bottom of the window, browse a folder where you want your video to be saved to.
6. Click **Upload** to save and upload your video.
Upload to Google Drive
1. Fill in the Title for your video.
2. Select a Google Drive folder where you want your video to be uploaded. Click the plus icon to create a new folder on the drive straight in the export window or click the refresh icon to see a folder that you’ve created in a web browser.
3. Open the Privacy box and choose who you want to see the video:
   - Private – videos can only be seen by you and the users you choose.
   - Unlisted – videos can be seen and shared by anyone with the link.
4. On the bottom of the window, browse a folder where you want your video to be saved to.
5. Click Upload to save and upload your video.

Upload to Vimeo
1. Fill in the title and description for the video.
2. Set the level of privacy:
   - Anyone – any person can watch the video.
   - Only people I follow – only people you’re subscribed to can watch the video.
   - Only me – nobody, but you can access the video.
3. Select the resolution of the video and add tags.
4. On the bottom of the window, browse a folder where you want your video to be saved to.
5. Click Upload to save and upload your video.

Program preferences
To open the program's preferences:
1. Click the Settings menu.
2. Select Preferences.

The Preferences window will open. The preferences are organized into tabs. Click a tab to open the relevant options.
See also:
General preferences
File preferences
Sharing preferences
Acceleration preferences

General preferences

Interface Language – to change the interface language, simply select the necessary language from the list and click OK to apply the changes.

Automatically check for updates – select this option and you’ll be notified whenever a new version is available. Updates within your version are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.

I give consent to send anonymous usage stats to Movavi – check this box to let the program send usage statistics to our development team and help us to fix all the problems in the program much faster. The data contains no personal information, will not be disclosed to third parties and will be used for software improvement purposes only.

Use software OpenGL implementation – this option can be useful if your computer doesn’t support the necessary OpenGL version and you see an error message when you start the program.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a software replacement. Installation will run automatically, but you will need an Internet connection to download the files.

If Movavi Slideshow Maker runs without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting

Play notification sound when exporting is finished – when saving a project as a media file, you’ll be notified as soon as the process is completed.
File preferences

On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different location.

Save project files to — a folder for saving and opening projects. This folder will also store any autosave files for new projects. You can use the autosave file to restore your work in case of an error or force close.

Save output videos to — a folder for exporting media files.

Store audio recordings in — a folder for the audio clips that you record in the Editor.

Store stabilized videos in — a folder for a stabilized copy of the original when you stabilize a video.

Changing where the files are stored

Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in another way.

1. Click the button with three dots next to the folder you want to change.
2. A Windows Explorer dialog box will open. Choose the folder you want to save the files to.
3. Click Select Folder to use this folder.
Sharing preferences

On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.

1. Select a service to upload a video to: YouTube, Vimeo, or GoogleDrive.
2. Click Sign In.

3. Sign in to your account.
4. In the browser window, allow Movavi Slideshow Maker to upload videos to your account.
5. Return to Movavi Slideshow Maker. Your name will be shown in the Preferences window.

To sign out or use a different account:
Click Sign Out. After this, you will need to sign in again to upload videos.

Acceleration preferences

If your computer is equipped with the necessary hardware, these options can help speed up encoding and decoding of media files, allowing you to save your movies much faster and enjoy smoother performance.
Enable Intel hardware acceleration
Accelerates video processing by up to 400% when working with H.264 and MPEG-2 video codecs. This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology, or Quick Sync Video 1.0 and higher.

Enable NVIDIA hardware acceleration
- With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to 50% faster.
- Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other programs.
This option is only available if your computer is equipped with an NVIDIA graphics card that supports this technology. NVIDIA acceleration supports GeForce, Tesla and Quadro graphics card series. You can find the full list of supported GPUs on NVIDIA®’s official site: NVIDIA NVENC supported GPUs.

Enable AMD hardware acceleration
- With this option enabled, you can use AMD’s graphics processing power for converting videos.
- Using the graphics card instead of the processor leaves your CPU free for other tasks, and you can use your computer without stuttering while converting videos.
This option is only available if your computer is equipped with an AMD graphics card, and has Video Coding Engine 1.0 and higher. See the list of all compatible graphics cards.

Fast Track HD Acceleration
Fast Track HD Acceleration provides smooth and fast program running. By enabling HD clips optimization in the Preferences menu you allow the video editor to create copies of the project files in a smaller size and then use them in the project instead of the original ones. To enable this feature you need to have free disk space, so the Editor can store and use the copies. Once you finish editing and begin export, high-quality files will replace all the temporary optimization copies.

Troubleshooting
If acceleration options are unavailable:
Your computer might not have the right hardware.
If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the manufacturer's website: Intel Download Center | NVIDIA Driver Downloads | AMD Download Center

Intel HD Graphics is a trademark of Intel Corporation.
NVENC is a trademark of NVIDIA Corporation.
AMD is a trademark of AMD Corporation.

Help and support
Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right away.
How to reach us
By e-mail: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!
If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information about your system will allow us to help you faster.

Frequently Asked Questions
What are the system requirements for using Movavi Slideshow Maker?
What formats can I save my slideshow in?
More frequently asked questions

Keyboard shortcuts
Editing video becomes much faster and easier if you learn a few basic keyboard shortcuts, especially if you're using a touchpad. You can find the list of shortcuts if you open the Help menu and select Keyboard Shortcuts.

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add media files</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>New project</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open project</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td>Save project</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save project as</td>
<td>&lt;TODO&gt;: insert variable value hereS</td>
</tr>
<tr>
<td>Split clip</td>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Insert freeze frame</td>
<td>Ctrl+E</td>
</tr>
<tr>
<td>Add keyframe</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>* For the Animation and Pan and Zoom tools</td>
<td></td>
</tr>
<tr>
<td>Full screen preview</td>
<td>Alt+Enter</td>
</tr>
<tr>
<td>Skip forward 0.5 seconds</td>
<td>Shift+Ctrl+→</td>
</tr>
<tr>
<td>Skip backward 0.5 seconds</td>
<td>Shift+Ctrl+←</td>
</tr>
<tr>
<td>Next frame</td>
<td>Ctrl+→</td>
</tr>
<tr>
<td>Previous frame</td>
<td>Ctrl+←</td>
</tr>
</tbody>
</table>

System requirements
Note that Movavi Slideshow Maker may also run on slower machines, however, we cannot guarantee stable performance if the minimum requirements are not met.

<table>
<thead>
<tr>
<th>Minimum system requirements</th>
<th>Recommended configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
<td>Windows XP/Vista/7/8/10 with latest service packs and patches</td>
</tr>
<tr>
<td>Processor</td>
<td>Intel, AMD or compatible processor, 1.5 GHz</td>
</tr>
<tr>
<td></td>
<td>Intel, AMD or compatible processor, 2.8 GHz and above</td>
</tr>
<tr>
<td>Graphics card</td>
<td>NVIDIA® GeForce™ series 6 or higher, AMD Radeon™ R600 or higher graphics card with up-to-date drivers</td>
</tr>
<tr>
<td></td>
<td>Your graphics card must support OpenGL 2.0 and above for the program to work correctly.</td>
</tr>
<tr>
<td></td>
<td>OpenGL 2.1 and above is recommended for smooth performance</td>
</tr>
<tr>
<td>Resolution</td>
<td>1024x768, 32-bit color</td>
</tr>
<tr>
<td></td>
<td>1280x1024 or higher</td>
</tr>
<tr>
<td>RAM</td>
<td>Windows XP – 256 MB</td>
</tr>
<tr>
<td></td>
<td>Windows Vista – 512 MB</td>
</tr>
<tr>
<td></td>
<td>Windows 7, 8, 10 – 1 GB</td>
</tr>
<tr>
<td></td>
<td>Windows XP – 1 GB</td>
</tr>
<tr>
<td></td>
<td>Windows Vista, 7, 8, 10 – 2 GB</td>
</tr>
<tr>
<td>Available disk space</td>
<td>280 MB for installation</td>
</tr>
<tr>
<td></td>
<td>2 GB for ongoing operations</td>
</tr>
<tr>
<td></td>
<td>Additional space required to save captured video and export projects.</td>
</tr>
<tr>
<td></td>
<td>Administrator permissions are required for installation</td>
</tr>
<tr>
<td>Additional features</td>
<td>Sound card for audio recording and playback</td>
</tr>
<tr>
<td></td>
<td>Intel® hardware acceleration requires a compatible Intel processor supporting Intel HD Graphics™ 2nd generation or higher</td>
</tr>
<tr>
<td></td>
<td>Learn more</td>
</tr>
</tbody>
</table>
## Supported formats

Here you can view the list of formats and codecs supported by Movavi Slideshow Maker.

### Video Formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Codec</th>
<th>Read</th>
<th>Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>3GPP, 3GP2 (*.*3gp, *.3g2)</td>
<td>H.263</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>H.264, MPEG-4</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>ASF – Advanced Streaming Format (*.*asf)</td>
<td>MPEG-4, VC-1, WMV V7</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>AVI – Audio Video Interleave (*.*avi)</td>
<td>H.264, MPEG-4</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>DivX Video (*.*divx)</td>
<td>DivX</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Flash Video (*.*flv)</td>
<td>H.264</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Flash Video (*.*swf)</td>
<td>FLV1</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MKV – Matroska (*.*mkv)</td>
<td>H.264, MJPEG</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>M2TS – MPEG Transport Stream (*.*m2ts)</td>
<td>H.264</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MTS – MPEG Transport Steram (*.*ts, *.mts, *.m2t)</td>
<td>MPEG-2, H.264</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>MPE – MPEG Version 2 (*.*mpg)</td>
<td>MPEG-1, MPEG-2</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MPEG (*.*mpeg, *.m1v, *.mod, *.tod)</td>
<td>MPEG-1, MPEG-2, H.264</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>MPEG-4 (*.*mp4)</td>
<td>H.264, H.264,</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>H.263, MJPEG, ProRes</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>MXF – Material eXchange Format (*.*mxf)</td>
<td>MPEG-2, DV</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>OGV – Ogg Video (*.*ogv)</td>
<td>Theora</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>MOV – QuickTime (*.*mov)</td>
<td>H.264</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>QuickTime (*.*qt)</td>
<td>MPEG-4, AIC, MJPEG, ProRes, Sorenson 1/3, PNG</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>RM – RealMedia (*.*rm, *.rmvb)</td>
<td>H.264, MPEG-4, AIC, MJPEG, ProRes, Sorenson 1/3</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>WebM (*.*webm)</td>
<td>VP8</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>VP7, VP9</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>WMV – Windows Media Video (*.*wmv)</td>
<td>WMV V8</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>WTV – Windows Recorded TV Show (*.*wtv)</td>
<td>H.264, MPEG-2</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

### Audio formats

<table>
<thead>
<tr>
<th>Format</th>
<th>Codec</th>
</tr>
</thead>
<tbody>
<tr>
<td>AAC – Advanced Audio Codec</td>
<td>AAC</td>
</tr>
<tr>
<td>Audio Formats</td>
<td>Compressed/Monkey's Audio</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>AIFF (*) .aif, *aiff</td>
<td>Uncompressed</td>
</tr>
<tr>
<td>APE (*) .ape</td>
<td>Monkey's Audio</td>
</tr>
<tr>
<td>AU (*) .au, *.snd</td>
<td>PCM</td>
</tr>
<tr>
<td>FLAC (*) .flac</td>
<td>FLAC</td>
</tr>
<tr>
<td>MP3 MPEG-1/2 Audio Layer III (*) .mp3</td>
<td>MP3</td>
</tr>
<tr>
<td>MPEG-4 (*) .m4a</td>
<td>AAC</td>
</tr>
<tr>
<td>OGG - Ogg Audio (*) .ogg</td>
<td>Vorbis</td>
</tr>
<tr>
<td>WAV - Waveform Audio File Format (*) .wav</td>
<td>PCM</td>
</tr>
<tr>
<td>WMA - Windows Media Audio (*) .wma</td>
<td>WMA 9</td>
</tr>
<tr>
<td></td>
<td>WMA Pro, WMA Voice</td>
</tr>
</tbody>
</table>

**Image formats**

BMP, DPX, GIF, JPEG, PGM, PBM, PPM, PCX, PNG, PTX, TARGA, XBM, XWD ✔

You can view the full list of supported devices here.

**OpenGL troubleshooting**

If you see the following message about OpenGL when you open Movavi Slideshow Maker or you've noticed that the player, filters, or transitions do not work, your computer most likely does not support the necessary version of OpenGL. To run Movavi Slideshow Maker, your computer needs to support at least OpenGL version 2.0, and version 2.1 is required for smooth performance.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:

**Step 1: Update your graphics card driver**

Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver installation file from the manufacturer's website and install it following the on-screen instructions. Detailed instructions on updating the driver

It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Slideshow Maker. If you see an error message again, proceed to the next step.

**Step 2: Try the software OpenGL implementation**

If your graphics card still doesn't support OpenGL 2.1 even after updating the driver, you can use a software alternative:

- In the message you see after starting Movavi Slideshow Maker, select the **Download and install software OpenGL implementation** box.

- Or, in the main Movavi Slideshow Maker window, open the **Settings** menu and choose **Preferences**. There, select the **Use software OpenGL implementation** option and click OK.
After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi Slideshow Maker.

If these steps haven't helped:
• Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.
• Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem.

Updating the graphics card driver

If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a driver update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance of applications and games on your computer.

Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type section. Note the full name of the graphics card somewhere for later.

Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There, look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility that will automatically find the necessary driver.

NVIDIA download center
AMD download center
Intel download center

Warning:
Only download drivers from the official manufacturer's website. Third-party websites offering driver downloads may contain malware.

Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the on-screen instructions to install the driver on your system. Your display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.

Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and allows you to optimize your computer's graphics performance.

1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application, please try the method above.

NVIDIA download center

2. In the Drivers section, click the Check for updates button to find the latest drivers.

3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download and install the necessary driver for your system.
Updating AMD® or ATI® Driver

1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD’s official website.
   [AMD Driver Download Center]

2. Download the auto detect utility and run it when the download has finished.
   [Auto Detect Utility]

3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.

   If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads page and download the driver.

4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.

5. After the driver has been installed, it is recommended that you restart your computer.

If none of the above steps have helped, feel free to contact our support team via e-mail or live chat.

If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have encountered. This will help our support team specialists solve your problem quicker.

**Glossary**

The following is a list of some terms that you may come across while working with video and audio. You won’t need to know all of these to use Movavi software, but if you want to learn more about the specifics of media file processing, you can start here.

**General**

**Aspect Ratio**

A video's aspect ratio is the ratio of a video's width to its height in pixels. The two most frequently used aspect ratios are 4:3 and 16:9. The former is used by most analog television broadcasts, while the latter, also referred to as widescreen – in films, DVDs, and modern HD video. When the aspect ratios of your screen and a video do not match, you may notice black bars on two sides of the video.

**Container Format (Video Format)**

A container format is a file format for storing video or audio files that contains video and audio data in separate streams, as well as any other associated data, such as subtitle tracks and additional data about the file. You can think of a container format as a box that holds together all the parts that make up a video file, as illustrated below. The container format is what you usually see when you work with video files: you can judge which format your video is in by the file extension: *.mp4 corresponds to MP4 format, *.mkv to Matroska format, etc. Since a container format only 'contains' different video streams, it is possible that two files with the same format may have video streams encoded with different codecs; therefore, one file may easily play in a player, while the other will not.

**Codec**
While a video file contains video and audio streams, these streams are in turn encoded using a video or audio codec that compresses the data. You can think of a codec as a language: to play a video encoded with a certain codec, your player needs to be able to 'understand' how it was encoded, so that it can decode or decipher the file. If your computer does not know how to decode a new codec, you can fix this by converting the file to a different format or by installing a codec pack. However, please keep in mind that a lot of malware programs disguise themselves as codec packs; you should only download codec packs directly from codec manufacturers or from trusted sources.

**Bitrate**

When referring to media, bitrate is the number of bits that is played back each second. The higher the bitrate, the more details that can be conveyed with each second of the video or audio stream, and therefore, the higher the quality. There are two types of bitrate: constant bitrate (CBR) and variable bitrate (VBR). Videos with constant bitrate (CBR), as you can probably guess from the name, have the same bitrate for each and every frame of the video, no matter the complexity of the frame: simple frames, for example, those completely filled with black, have the same number of bits as complex, colorful frames. This has a number of limitations, since the simple frames take up more bits than needed to convey them, while complex frames are limited in quality. With variable bitrate, however, each frame is allotted only as many bits as it needs, without limiting quality or wasting data. In most cases, we recommend that you use variable bitrate, however, you CBR is sometimes useful for streaming media.

**Frame Rate**

The frame rate, or frames per second (FPS) is the number of video frames that is contained in a second of video. At low frame rates, you may notice that the video is 'jittery', while higher frame rates produce a smooth high-quality video. Shooting videos at high frame rates (48 or 60 FPS) requires more resources and disc space, but you can easily slow down a high-FPS video to produce a slow-motion effect without producing visual stutter. The industry standard for cinema frame rate is 24 or 25 frames per second, which is perceived as comfortable to the human eye.

**Interlaced Video, Deinterlacing Video**

Video interlacing is a method used in traditional analogue video broadcasting that arose due to the limitations of early television. Each frame of the video is split into half-frames, each frame containing even and odd rows consecutively. This allows to broadcast at double the frame rate, producing a seemingly smoother video stream, while the eye does not notice the missing rows. However, on digital displays, interlaced video may produce visible defects in the form of horizontal lines. Deinterlacing helps remove these defects using algorithms by merging the two half-frames into one.

**Remuxing**

Many container formats support a number of common codecs, such as H.264, which can be stored in MP4, AVI, M2TS, MKV, MOV, and other formats. When you convert a video that is encoded with a codec supported by both the input and output container formats, you can simply transfer the video stream from one container format to another, without having to re-encode it. This process is called remuxing and it allows you to save a lot of time, since video re-encoding is the longest part of the conversion process.

**Resolution (Frame Size)**

Resolution is the number of pixels that can fit inside the video frame. It is usually presented as "width x height" of the frame, for example, 1280x720 or 1920x1080. Sometimes, resolutions may also be referred to as "720p" or "1080p", by the number of pixels in a frame vertically. At high resolutions, each frame is conveyed using more pixels, therefore allowing for more detail and higher quality, though taking up more disc space. Whenever you convert a video to a lower resolution, you irretrievably lose some data, but if you convert a low-resolution video to HD, the quality will stay the same.

**Sample Rate**

Sample rate, measured in Hertz, determines how many samples of digital audio are recorded each second. Higher sample rates allow to record higher quality audio, although the files will take up slightly more space. The recommended sample rate is 44100 Hz, which is the standard for audio CDs, delivering sound that covers the full range of human hearing. To reduce file size, you can convert audio with lower sample rates, as low as 22 kHz, but keep in mind the quality deterioration.

**Subtitles**

A subtitle is text that appears on screen (usually at the bottom) that reproduces the video's dialogue or presents additional explanatory text and sound effects. Subtitles are frequently used by people hard of hearing, language learners, and when an audio translation is unavailable. The subtitles may be embedded within the video container file (also known as softsub), saved as a separate file in *.srt, *.ass, *.sub, and other subtitle formats, or drawn over the video stream in such a way that they cannot be disabled (hardsub).

**Video Formats**

**Audio Video Interleaved – AVI (*.avi)**

AVI is a multimedia container format created by Microsoft in the early 1990s. AVI supports multiple video and audio codecs and can contain up to 16 audio and 16 subtitle tracks. While support for AVI is widespread on all operating systems, it is steadily being replaced by more efficient formats.

**DivX (*.divx)**

DivX is a proprietary video format developed by DivX, Inc. Using its own codec, DivX allows for high compression rates while retaining high quality. Sometimes the DivX codec is also used to encode video in AVI files. DivX is not supported by many media players, and requires a codec pack to play. Movavi applications can open DivX files without any additional software.

**Flash Video Format – FLV (*.flv)**

Developed by Macromedia and currently owned by Adobe, FLV is frequently used for web video, as it is supported by most web browsers and is accepted by most video sharing services and social networks. FLV can contain video encoded in Sorenson, FLV1, VP6 and H.264 codecs.

**QuickTime – MOV (*.mov)**

Developed by Apple, QuickTime is natively supported on Macs and iOS devices, so if you need to be sure that your video can be played on a Mac, converting it to MOV would be a good idea. If you are preparing your files to also be played on a Windows computer, it's best to convert it to MP4, as Windows computers need to download and install QuickTime from Apple's official website in order to play MOV videos.

**SWF (*.swf)**
Developed by Macromedia and currently owned by Adobe, SWF (formerly Shockwave Flash) is a video and graphics format related to Flash video that can contain video, animations, vector images, and other content. Usually created in proprietary Adobe software, SWF files are supported by Adobe Flash Player and most web browsers, which makes it an efficient way of sharing content online due to the small file size.

WebM
WebM is a free open-source container format developed by Google. It primarily functions as a widespread web video format that can easily be embedded in HTML5 video tags. WebM can contain video encoded in the free VP8 and VP9 video codecs and Vorbis audio.

Movavi File Formats
*.mep, *.mep2, *.mepx
Used in Movavi Video Editor to create editing projects that store file references, order of files on the timeline, applied effects, and all other work on the project. Please note that projects created in older versions may not be compatible with the most recent version of Movavi Video Editor.

*.meps
Used in Movavi Slideshow Maker to create editing projects that store file preferences, order of files on the timeline, applied effects, and all other work on the project.

*.mscproj, *.mrec
Used in Movavi Screen Capture to store temporary recording data, including the recording itself, as well as all settings used for the project.